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摘要 

關鍵詞: 珊瑚礁、立體結構、運動恢復結構、三維模型 

Keywords: Coral reefs, Structural complexity, Structure from Motion, 3D model 

 

珊瑚礁有極複雜的立體結構，提供各種生態功能並造就豐富的生物多樣

性，但是如何將複雜的立體空間量化，以評估珊瑚礁的功能狀態是一項重要課

題。本研究選定台灣北部基隆市的潮境海灣資源保育區，嘗試以運動恢復結構

(Structure from Motion, SfM)方法，建立高解析度的珊瑚礁 3D模型，並搭配

GIS 軟體進行斜度(slope)、VRM(Vector Ruggedness Measure)、粗糙度(rugosity)

等參數分析，取得三維空間的量化資料，進行不同環境條件或時間序列的比較

研究。本研究分為兩部分，(一)不同底質特徵(如珊瑚礁、岩塊、沙地與海藻)

及不同珊瑚體形態 (如分支形、團塊形、葉片形…等)的空間參數分析，(二) 

沿水深 10米等深線，依人為干擾程度設置 6個邊長 5米的方框，進行人為擾動

對珊瑚礁立體結構的影響分析。調查結果能產生解析度毫米級(mm/pix)的數值

高程模型(digital elevation model)與正射影像鑲嵌圖(orthomosaic)，斜度在礁體

或生物構造的邊界有顯著的變化(74~89 度)，分支形與表覆形珊瑚分別有最高

與最低的表面粗糙度(6.39、1.83)，VRM可以明顯區別複雜(>0.25)與簡單(<0.15)

的珊瑚種類，多邊形網格模型(mesh model)中點(vertices)與面(faces)的數量能

反映出立體結構的複雜程度。至於成果展示的部分，能藉由三維建模過程中產

生的深度貼圖(depth map)，使二維的照片產生類似立體的視覺效果，使用

Blender 軟體能製作精美的立體動畫，3D物件適合使用 Sketchfab 網站分享呈

現，也能利用 3D列印製作實體的珊瑚礁或其他固著生物的模型，未來隨著硬體

設備升級與 AI 深度學習的發展，以此方法蒐集的量化數據將能更有效的保存完

整的珊瑚礁生態、水下景觀及文化資產等資料，並應用於生態研究、保育、復

育、展示和環境教育等領域。 
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珊瑚礁立體結構量化與分析- 以基隆市潮境海灣資源保育區為例 

 

一、前言 

(一)研究緣起 

珊瑚礁最明顯而重要的特徵就是空間複雜性，造礁珊瑚藉由生長和堆積碳

酸鈣骨骼形成立體而多樣的空間結構，提供許多海洋生物棲息、繁殖或覓食的

場所，不僅有助於維持生物多樣性，也提供許多生態系服務(圖 一)，包括；海

岸保護、漁業資源、遊憩資源和天然藥物資源等 (Moberg & Folke, 1999)。 

珊瑚礁的空間結構也與環境健康狀態緊密相關。健康的珊瑚礁擁有複雜多

樣的空間結構，形成各種類型的微棲地，支撐了高生產力、豐富的漁業資源，

生物多樣性和生態系恢復力；另一方面，當珊瑚礁呈現衰退或被破壞時，空間

結構就會趨向單調化，立體結構逐漸崩解，朝向 2D 平面化，導致生物多樣

性、生產力、漁業和景觀資源同時喪失 (Wilson et al. 2007; Goatley & Bellwood, 

2011 ; Graham & Nash, 2013)。因此，空間結構是評估珊瑚礁健康狀態的重要指

標，而建立高效率且準確的方法，以量化珊瑚礁空間結構，為珊瑚礁保育亟待

研究和發展的議題。 

 

圖 一、珊瑚礁空間結構的重要性 (Moberg & Folke, 1999) 

(二)研究目標 

     本計畫將嘗試建立珊瑚礁立體結構量化的方法和作業流程，分析珊瑚礁生
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態系生物與非生物底質的空間結構差異，比較不同空間參數與人為擾動梯度的

關係，建立以空間結構評估珊瑚礁生態系健康狀態的標準化方法，並嘗試各種

展示 3D 模型的途徑。 

 

(三)問題背景 

由於珊瑚礁的空間結構非常複雜，量化困難，因此傳統文獻中大多使用等

級分類法，例如將空間結構複雜度分為三至五等級，分別給予不同定義，由潛

水調查人員依目視情況判別，這種方法難免不夠客觀；此外，有些學者使用測

量穿越線表面粗糙度 (礁體表面距離/直線距離)的方法，但是此法又有過於簡化

之嫌(Friedlander & Parrish, 1998; Wilson et al., 2007)。   

 近年來，使用「運動恢復結構」(Structure from Motion, SfM) 的攝影建模技

術已被應用於建立珊瑚礁的空間結構(Burns et al., 2015; Leon et al., 2015)，藉由

不同位置及拍攝角度的相片，將二維的平面資訊轉換成三維的立體模型，並進

一步利用空間結構分析軟體，進行坡度、曲率、覆蓋率、表面複雜度等空間參

數計算，最後利用得到的量化參數進行統計分析，以判別不同底質的特徵，例

如軸孔珊瑚、微孔珊瑚、沙地或岩石之間的異同，藉此技術更精準的量化與評

估珊瑚礁空間結構。 

這種珊瑚礁空間結構的量化方法，未來若被廣泛使用於不同地點珊瑚礁空

間分析，隨著這些空間參數資料的累積，將能更細緻的探討氣候變遷與各種環

境擾動對珊瑚礁結構的影響，並且可做為歷史資料，記錄的珊瑚礁三維模型將

可如同二維的傳統相片保存下來，可以保存珍貴的生態系環境空間資訊；除此

之外，立體的珊瑚礁模型也能藉由時下流行的 3D 列印輸出或以 VR 觀賞，應

用於環境教育的推廣，配合硬體運算能力的進步與人工智慧的發展，將能大幅

提升和推廣三維資料的應用。 

 

(四)文獻回顧 

SfM 的三維空間研究方法，在國外已經被應用於諸多領域，例如：在林業

上，用於分析樹木分枝的體系結構(Morgenroth & Gómez, 2014)；在水下考古領

域則用於沈船或古物的量測及文物資料的保存(McCarthy & Benjamin, 2014)；關

於珊瑚礁生態調查，也有針對柳珊瑚進行形態學和估計其生物量的研究(Palma 

et al., 2018)；更備廣泛應用於航拍圖、空拍機或衛星照片分析，以呈現地表高

程變化 (如 Westoby et al., 2012; Fonstad et al, 2013)；在台灣則有應用於分析農

作物的高度特徵，以增加物種判釋能力的研究 (林，2015)。 

 在珊瑚礁研究領域，Burns et al (2015)及 Leon et al (2015)為首次應用 SfM

技術於水下珊瑚礁空間結構的研究。上述研究皆著重於新方法及分析技術的建

立，因此相關研究方法及過程的描述都很詳細，包括建立 3D 珊瑚礁模型及空

間結構性質分析，由於兩者皆搭配付費軟體，計算諸如線性粗糙度、曲率、坡

度、表面複雜度等，具有重要生態意義的空間指標。 
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(五)現況分析 

1.SfM 的原理與不同三維建模方法的比較 

SfM 建立 3D 模型的方法源於人對三維空間的感知，人的眼睛之所以能判

別某物件是否為立體，主要依靠物件的移動或旋轉造成的陰影和深度變化，此

現象稱為動態深度效應(Kinetic depth effect)。目前有許多市售軟體(例如: Agisoft 

Photoscan、Pix4D、Altizure)能自動進行有關的數學運算，藉由密集拍攝同一物

件不同位置與角度的重疊影像，進而分析個別照片特徵點的深度及陰影變化(圖

二)，重建出這些特徵點的三維資訊 (Westoby et al., 2012；黃&陳, 2013)。本計

畫所要拍攝的珊瑚礁環境，不同於拍攝小體積且可移動的物件，通常僅能從受

限制的角度進行拍照取樣，因而較類似於無人機或人造衛星所空拍的正射影像

(orthophoto)。 

 

圖 二、SfM 原理示意圖 (引自: Westoby et al., 2012；黃&陳, 2013) 

  

傳統上，可以藉由聲納(SONAR)或光達(LiDAR)建立地景的三維模型，原

理不同於分析影像資訊的 SfM，聲納與光達皆利用反射波進行空間量測，聲納

主要用於量測海底地形或偵測魚群動態，其缺點為無法偵測細部的空間結構及

無顏色資訊，而光達則主要用於量測地表的高程起伏及無人車的碰撞感應，其

缺點為長波長電磁波在水中的穿透力較差且價格較昂貴；至於 SfM 的影像取

樣，僅需要防水的攝錄影機即可操作，在深海環境也可搭載於 ROV 之上，因

此較方便又簡單的操作方式，有利於此方法的推廣與應用。 

 

2.SfM 方法的限制與準確度分析 

 儘管 SfM 為新興的研究方法，國內外已有一些不同條件下的精確度比較研

究。首先，SfM 會受限於取得的影像資料品質，例如在混濁度愈高的水中拍攝

同一物件，可供 3D 建模的資料點就愈少，最後產出的立體模型也會因而失真

(Bruno et al., 2011)，再者，在野外調查中也需仰賴固定光源，不可在拍攝個別

照片時使用閃光燈，否則會影響分析軟體對於深度和位置的計算(Burns et al, 
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2015)，當然也無法使用於夜晚，而且被遮蔽或位於陰暗處而無法被相機偵測到

的結構也是無法重建的。 

 雖然有上述的一些條件限制，在正常的環境下使用 SfM 仍是簡便有效的方

法，例如針對同一個死亡珊瑚體在不同時間，使用相同方法進行量測的體積與

表面積，結果的誤差都在可接受的範圍(Raoult et al., 2017)；另外，在陸地上的

高程起伏分析，比較使用 SfM 與傳統光達所建立的地形模型，結果都很相近且

精準 (Fonstad et al., 2013)。 

 

(六)研究重點及預期成果 

1. 建立基隆市潮境海灣資源保育區的珊瑚礁空間結構，有助於了解該區生態特

徵，做為保育區資源管理和未來長期監測使用，可用於未來發生擾動事件(例如

颱風或汙染事件)的生態損害評估。 

2. 建立各類型珊瑚礁棲地的空間結構特性，包含量化方法與評估準則，可應用

於未來評估珊瑚礁監測與評估其健康狀態的重要指標。若能隨時間累積各珊瑚

礁區數值化空間參數，可以搭配環境因子進行更深入的研究，對分析珊瑚群聚

的動態及評估生態系健康更有助益。 

3. 建立珊瑚礁空間結構量化和分析的標準作業流程，可以提供相關研究的參

考，或推廣給一般民眾與公民科學家使用，進而提升現有珊瑚礁調查的效率及

資料品質。 

4. 產生一目瞭然的三維模型，能更容易了解底棲環境的空間變化，應用於珊瑚

礁體檢報告及生物資料庫中，增進資料的閱讀效率。 

5. 數位化的珊瑚礁 3D 模型，亦可做為一種新的資料展示途徑，方便於社群媒

體推廣海洋科普教育，利用時下流行的 3D 列印輸出或 VR 製程，更能做為推

廣教育的展示模型。 

 

三、研究方法及過程 

(一) 研究地點 : 基隆市潮境海灣資源保育區 

潮境位於基隆市八斗子半島東側(圖 三)，與深澳岬角形成面積約 250 公頃

的海灣，鄰近國立海洋科技博物館(簡稱海科館)，近年來部分海域已被基隆市

政府公告為”基隆市望海巷潮境海灣資源保育區”，由於政府與民間合作落實執

法，因此保育成效非常良好，成為周遭海域生物資源的重要種源庫，也是萊氏

擬烏賊(俗稱軟絲)等許多海洋生物的產卵場，因此維持了很高的生物資源量，

甚至吸引難得一見的海豚和海龜前來覓食，海洋生物的豐富度與完整性堪稱是

北台灣之最，因此本研究擬針對此保育區與鄰近海域進行礁體空間結構的分析

研究，預定選取各種典型的礁體生態系(圖 五)，例如：不同類型珊瑚群聚、沙

底、礁岩平台、礁斜坡等地形作為樣區，各類樣區選取面積為 5 m X 5 m 的礁

體拍攝影像。 
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圖 三、潮境海域的地理位置，位於基隆市中正區與新北市瑞芳區交界處 

畫調查位置圖 

 
圖 四、潮境海域深度與測站位置圖，底圖來源 http://webapp.navionics.com 
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圖 五、潮境海域的水下景觀與生態複雜性  

 

(二) 研究過程與方法 

1. 研究過程  

   本研究將參考 Burns et al (2015)及 Young et al (2017)的珊瑚礁空間結構重建

方法，應用於台灣海域的珊瑚礁空間結構量化與分析，並針對此方法的準確性

及在珊瑚礁保育上的應用性進行評估，以建立適用於台灣珊瑚礁空間結構分析

的方法，研究過程如圖 六所示。  

 
圖 六、研究流程及工作項目概念圖 

 

2. 地面控制點設置 

進行水下攝影工作前需先設置地面控制點(Ground Control Points, GCPs)，

GCP 的意義在於提供建立珊瑚礁三維模型的精準定位參考座標，GCP 最好詳細
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記錄經緯度座標及深度等位置資訊，設置的位置為樣區的各個角落及線段的中

間點(圖 七)，材質常用三根互相垂直的塑膠管拼接而成，通常會搭配有黑白交

錯方格的壓克力板(圖 八)，用以增加後續在軟體標記時的辨識能力。 

 

圖 七、地面控制點示意圖(引自: Young et al., 2017) 

 

3. 水下攝影取樣方法 

針對樣區的水下攝影，拍攝路徑為牛耕狀 (boustrophodonic) (圖七)，此種路

徑最節省時間，並確保樣框內所有區塊都能拍攝到，也可以使拍攝的影像連

續，以利後續 3D 建模軟體操作，潛水拍攝時，最好能維持固定深度約 2m，以

增進資料品質，每張拍攝影像必須密集重疊，彼此互相覆蓋的面積要在

70~80%以上(Burns et al., 2015)，方可使不同影像的關鍵點產生連結。本研究擬

拍攝取樣的樣區邊長為 5 m 的矩形，主要受限於後續的硬體運算能力，因為取

樣面積越大，影像檔案資料量越大，會大幅增加電腦運算時間與當機的風險。  

 

圖 八、攝影路徑及地面控制點的模型示意圖。左圖中黑線為牛耕狀的攝影路
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徑，右圖為地面控制點的參考模型 (Young et al., 2017; Palma et al., 2018)。 

 

本研究亦針對較小範圍的珊瑚礁進行更高解析度的取樣，因進入秋季後東

北季風漸強，潮境海域多數時間水質混濁，能見度經常低於五米，受限於相機

設備之品質，無法於拍攝距離 2~3m 時取得合適的清晰影像(圖 九)，故進行各

類底棲特徵量化分析研究時，採用 0.5~1m 的較近距離，並用環繞式的拍攝路徑

(圖 十)，藉此取得品質較高的影像，以建立更接近真實的立體模型。 

 

圖 九、不同能見度之相片品質比較圖，左圖光照差且濁度高，較右圖難分辨底

棲環境特徵，兩者皆使用 Olympus TG-4 於相同設定下拍攝。 

 
圖 十、近距離拍攝路徑示意圖，環繞物體取得不同的角度，並以不同高度拍攝

取得涵蓋各範圍的影像，越複雜的結構需拍攝越多張數，確保能完整呈現真實

環境的立體結構 
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4. 三維空間模式建構 

本研究使用的 SfM 建模軟體為操作相對簡單且功能強大的 Agisoft 

Metashape。Metashape 主要操作流程如以下五個步驟: (1)校正相片位置，(2)建

立點雲(point cloud)，(3)產生密集點雲，(4)建立多邊模型(wireframe model)，(5)

建立及輸出數值高程模型(Digital Elevation Model, DEM)。首先需要輸入互相重

疊且連續的照片，校正相片位置會運算出每張影像拍攝時的深度及角度，若有

正確設置地面控制點，此步驟可以運行的更快；再來就會依靠相片中的特徵點

建立點雲，產生點雲後需要刪除部分離群值(outlier)，避免影響後續三維模型建

立的準確度，若是僅產生點雲無法建立細緻的多邊結構，因此還需要進行產生

密集點雲的運算，並依照此結果產生可進行空間參數運算的立體模型，最後才

能夠輸出數值高程模型(DEM)，並使用 ArcGIS 的結構分析工具運算表面複雜度

及曲率等參數，也可利用相片中的顏色資訊產生材質模型(texture model)增進物

種的辨識能力，詳細流程請參閱結果討論與附件一。 

 

5. 空間參數分析以及底棲特徵分類 

空間參數的計算方法使用 ArcGIS 內建的分析工具，預計分析以下六種空

間參數：(1) 線性粗糙度(linear rugosity，平均實際長度/平均線性長度)，(2)覆蓋

率 (percent cover)，(3)表面複雜度(surface complexity，3D 面積/2D 面積)，(4)斜

度(slope，單位分為 percentage 與 degree)，(5)曲率 (curvature，在 ArcGIS 中可

得出三種立體空間中的曲率-profile curvature，planform curvature，combine 

curvature)，(6) VRM(Vector Ruggedness Measure)，VRM 是用來計算地形粗糙度

的一種指標，需先設定鄰近單元(Neighborhood Size)的大小(圖 十一)，每個單元

會得出其坡度與坡向(aspect)，並綜合其鄰近單元計算粗糙度，數值介於 1 至 0

之間(Sappington et al., 2007)。此六種空間參數根據前人研究皆有重要的生態意

義(Pittman et al., 2009；Pittman & Brown, 2011；Price et al., 2019)，得出的數值

會再使用 Python 進行各類統計分析，比較不同底棲特徵是否有顯著差異，最後

產出的三維模型圖，相對於傳統的二維影像圖，更能一目瞭然的判斷底棲環境

特徵。 
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圖 十一、不同鄰近單元大小計算 VRM 之比較圖，使用較大的鄰近單元可以較

好的反應特定範圍內的地形粗糙度，但是計算結果也容易受到周圍的影響而有

較大的偏差，本研究使用約 1.64 公分的單元進行運算(鄰近單元的數值與實際對

應單位取決於 DEM 的解析度)，需另外下載 ArcGIS的擴增工具 Benthic Terrain 

Modeler(BTM)計算，相關參考文獻可參閱 Walbridge et al., 2018。 

  

 珊瑚的結構型態分為八類(表 一)：(1)分支形 Arborescent，(2)灌叢狀

Bushy，(3)桌形的 Table，(4)柱形 Columnar，(5)團塊形 Massive，(6)表覆形

Encrusting，(7)獨立形 Unattached，(8)葉片形 Foliose，這些形態特徵根據前人

研究皆具有不同的生態意義(Denis et al. 2017)，其中獨立形、灌叢狀、桌形與柱

形本次研究中較少記錄，除了珊瑚尚有其他分類：桶狀海綿、大型藻、礁岩、

沙地，這些分類有許多肉眼可辯的特徵，且在樣區中為數不少故獨立出來探

討。 

 

表 一、珊瑚型態分類表 (參考文獻 Denis et al. 2017) 

 

Arborescent 

(branching) 

 

Bushy 

 

Table 

 

Columnar 

 

Massive 

 

Encrusting 

 

Unattached 

 

Foliose 
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四、結果與討論 

(一) 建立珊瑚礁立體結構標準作業流程  

本節參考 Scripps Institution of Oceanography 一百島嶼挑戰計劃之標準作業

流程(http://100islandchallenge.org/)、Burns et al. (2015)、Fukunaga et al. (2019)、

Young et al. (2017)、Agisoft 官方軟體說明文件與論壇(https://www.agisoft.com/)

以及個人經驗彙整而成。 

1.採樣前工具準備  

 進行野外潛水工作之前，需先準備以下用於 3D 建模的基本工具(圖 十

二)。地面控制點(Ground Control Point, GCP )為協助 3D 建模軟體進行影像辨識

的標記，可以用於針對部分相片進行位置校正)，也能用於建立精準的在地座標

系(Local coordinate)，本研究設計的 GCP 為面積 12 X 12 cm、厚度 8 mm 的壓克

力片(圖 十三)，背面黏貼配重以免水流強勁時移位，中間的圖樣為軟體影像辨

識的位置，每個標記皆有不同的環形排列，完整標記文件可至 Agisoft 

Metashape 軟體中下載(圖 十四)，邊緣之色塊用於相片的顏色校正，黑色的方

格與條紋陣列用於偵測相機鏡頭使否有光學扭曲的現象。 

A.地面控制點(Ground Control Point) B.捲尺(Measuring-tape) 

  

協助 3D 建模軟體建立坐標系與影像

辨識 

測量並劃分拍照取樣範圍，以及協助

潛水員取樣時的路徑定位 

C.配重 D.指北針 

  

固定水中工具以及定位裝置 用於標定取樣範圍的方位 

E.潛水錶 F.水平儀 
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記錄深度與規劃潛水時程 用於確定地面控制點擺放為水平 

G.比例尺 H.手持 GPS 

  

協助 3D 建模軟體建立符合真實世界

的距離 

標記測站位置 

圖 十二、珊瑚礁

立體模型建立基

本工具列圖(A~I) 

 

 

I.防水相機 

 

拍攝用於建立 3D 模型的照片，兩台相機設定不同的焦距 
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圖 十三、地面控制點設計圖(使用 Adobe illustrator 製作) 

  

 

圖 十四、影像辨識標記，可於 Agisoft Metashape 命令列中依序點選 Tools→

Markers→Print Markers 下載完整 pdf 文件 
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2.相機設置 

由於 3D 模型的建立是根據 2D 照片而成，故相機的品質與模式設定會對結

果有重要的影響。本研究使用 Olympus Tough 系列相機，並配備 PT-056 專用防

水殼，攝影裝置以 TG-3、TG-4 兩台相機串連而成(圖 十二)，分別設置焦距

(focal length)為 4.5(F=3.2、放大倍率 X2)及 8.99(相機預設)，用以捕捉不同解析

度的影像，模式設定為間格攝影每秒拍攝一張，每張照片皆為 1200 萬畫素。 

本研究亦嘗試以運動攝影機 GOPRO HERO 4 進行取樣，由於廣角鏡頭會

扭曲影像使得距離失真，故需將攝影模式由 W(廣)調至 N(窄)或是以濾鏡校正，

並用錄影模式節省拍攝時間，後續再使用開源軟體 FFmpeg 進行截圖處理，然

而其內建光圈不足以應付水濁或昏暗的環境，且以截圖方式產生相片會缺失影

像資訊(如 ISO、快門、光圈值等)，若在陸地上使用則能搭配三軸穩定器，可以

減少相片模糊增進照片品質(圖 十六)。 

 國外文獻則多使用單眼相機(如 Nikon D7000)配備專業防水殼(如 Ikelite)進

行取樣(圖 十五)，可進行更為細緻的光圈以及快門設置，並同時使用 18 mm 以

及 55 mm 的鏡頭，高規格的光學元件可增進照片品質，並使建立的模型更精

準，本研究受限於經費而未能採用。 

 

圖 十五、國外文獻之攝影設備(一百島嶼挑戰計劃之標準作業流程 Version 2.0) 

 

圖 十六、GOPRO 相機搭配三軸穩定器 
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3.潛水攝影採樣流程 

 潛水工作首先以捲尺建立 5 X 5 m 的樣框，四個角落以鉛塊固定避免受水

流移位，用指北針確認其四邊符合東西南北方位，樣框邊緣放置一南北走向之

比例尺，於樣框內均勻散佈地面控制點(約 10~12 片)並記錄每一點的水深(圖 十

八)，設置完畢後使用相機進行攝影，路徑採取牛耕式圖案確保不會拍攝到重複

範圍，潛水移動時需盡可能保持均速和平穩，並維持在固定水深(離地面約 2 

m)，每張照片之間至少需要 70~80%的重疊，過程中需注意水流造成的位移和

速度改變，可以地面的環境特徵和 GCP 做為參考指標，在 5 X 5 m 樣框內約拍

攝 800~1000 張照片，依底部環境的複雜度可以有所增減，總耗時約 30~50 分

鐘，足夠在一支氣瓶的潛水時間完成(深度 10 m 左右)，至於 GPS 記錄，則需另

外派遣一組人手划小艇在水面上或是用浮球裝置手持式 GPS 記錄位置，或是開

啟防水相機的 GPS 功能，於拍攝完畢時垂直上浮取得位置訊號，另外，本研究

亦曾嘗試使用 WATER LINKED 公司的水下 GPS 系統，該儀器能透過岸基的定

位器，向水下的接收器發送聲波訊號，能夠取得更加精確的定位資訊，然而因

該儀器操作較為繁複而作罷，整體水下作業流程及記錄表格如圖 十七及圖 十

八。 

 

圖 十七、潛水工作流程簡圖 

相機設定 

樣框佈置 

地面控制點與 

在地坐標系設定 

攝影取樣 

GPS 定位 

1) 調整至間格攝

影模式 

2) 拉取 5X5公尺

方形樣框 

3) 均勻散佈 GCPs

以及擺放 XY

軸座標比例尺 

4) 穩定且與地面

保持固定距離

游動並以牛耕

式圖案攝影 

5) 垂直上浮水面

獲取位置訊號 

工作內容 

⚫ 兩台相機最好設

定在不同焦距 

⚫ 以重物固定樣框

及 GCPs 避免水

流造成移動 

⚫ 儘量使 GCP標記

水平於地面 

⚫ 注意水流對移動

路徑的影響 

⚫ 設置固定樁方便

進行同地點不同

時間的調查 

流程 
注意事項 
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圖 十八、樣框佈置示意圖 

 

 
圖 十九、工作記錄表 

 

4.立體模型建立方法 

 本研究使用 Agisoft 公司出品的 Metashape 專業版軟體(2019 年前原名

Photoscan)，使用運動恢復結構(SfM)演算法產生立體模型，其他類似功能的市

售軟體還有 Pix4D、3Dsurvey 等，國外多數相關文獻皆使用 Agisoft Metashape

軟體，因其介面好操作、運算快、結果品質佳，關於不同軟體間更詳細的比較

可以參閱 Alidoost F et al.(2017)以及 Burns J & Delparte D (2017)。 
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 安裝軟體之前需特別注意電腦的硬體規格，因其運算過程相當消耗電腦資

源，主要影響因子有三: CPU、記憶體、顯示卡，最低建議門檻以及其他資訊整

理如表二，本研究使用 Intel i7-7700 中央處理器、NVIDA GTX1070 顯示卡以

及 32GB 的記憶體容量，處理 800~1000 張相片(12M 像素)約需 3~4 個小時。 

 

表 二、硬體建議門檻 

配備名稱 中央處理器

CPU 

記憶體 RAM 顯示卡 GPU 適合處理相片

張數 

最低 i5 16MB GTX980 200 以下 

中階 i7 32MB GTX1080 800 左右 

高階 i9,  

Xeon 系列 

64MB 

或更高 

TITAN 系列 

Quadro 以上 

1000 以上 

 

 Metashape 軟體建立可供分析的立體模型主要分為六個步驟(表 三)，詳細

在軟體中的操作流程與事前的環境設定及注意事項請參閱附件一: 

(1)校正相片: 分析相片的拍攝位置與角度，並根據影像中的特徵計算關鍵點

(key point)，而後分析所有照片中有多少關鍵點彼此重合(tie point)，就此換算出

每一點在三維空間的位置資訊(圖 二十)，最後產生稀疏點雲(sparse point 

cloud)，此階段結果未必能反映出物件真實的立體結構，該點雲僅代表全部相片

校正後有多少點產生關聯，本研究設定的 Key point limit 為 50,000、Tie point 

limit 為 5,000，其餘皆套用軟體預設。 

 

圖 二十、校正相片步驟說明，左為照片中之關鍵點，右為相互重疊照片關鍵點

的關聯 

 

(2) 最佳化相片校正: 由於校正相片的過程中可能會遺漏部分關聯較弱的照片，

故有時需要手動在 GCP 上放置標記，人為告訴軟體該點在實際空間中的位置，

若有照片過於模糊則需刪除其校正，否則會產生雜訊降低模型精確度，確認所

有適合的照片皆校正完畢，即可執行最佳化校正功能，本研究套用其所有預設

選項，包含焦距、點坐標系、偏度、徑向以及切向的扭曲校正。 
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(3) 建立密集點雲: 此步驟會根據校正相片的結果，產生許多包含三維空間資訊

的密集點，密集點雲即可明顯觀察出珊瑚礁的立體構造，由於會產生出一些並

非在樣框中的點，因此需要於此時調整選取的範圍或是刪除多餘的點，用以節

省後續的運算時間，在本階段會非常消耗 CPU 的資源，本研究設定 Quality 為

Medium、Depth filtering 為 Mild，此設定可以較佳的保留細微結構。 

 

(4) 建立網格模型: 使用密集點雲的點串連出多邊形網格(mesh)，用來呈現立體

物件的頂點(vertices)與表面(faces)，其數量可以反映出底棲環境的複雜程度，此

階段非常消耗記憶體，若記憶體不夠則有程式終止的風險，點間若有小破洞會

執行內插補充，距離過遠的點則會被犧牲，成品會更接近真實物件，也能加上

陰影增加立體效果，若想得到更接近真實的色彩外觀，則需另外執行建立材質

(Build Texture)指令。 

 

(5) 在地坐標系設定: 為了使後續分析能符合實際的比例，若能獲得每張照片的

經緯度座標，則可使用 WGS(World Geodetic System)系統，在校正校片時也能

大幅加快速度。然而本研究受水下操作及設備的限制，需要手動輸入點與點間

的相對距離定義在地坐標系統，以 GCP 上已知的互相垂直 3 點為 XY 軸而 Z 軸

設為水深，並輸入比例尺長度以評估誤差，最後需注意投影方向是否有平行地

面，若於陸地上有 GPS 訊號的地方情況會簡單很多。 

 

(6) 產生數值高程模型及正射影像鑲嵌圖: DEM 能夠反映珊瑚礁區的高低變

化，資料中每一個像素代表一筆高度資料，故實際上僅能稱之為”2.5D”的模

型，因為若是在同個像素上有重疊的結構則無法呈現，正射影像鑲嵌圖為軟體

運算出的拼接空拍全景圖，圖中任兩點的距離即代表其在真實世界的垂直投影

距離(圖 二十一)，將以上兩者匯入 GIS 軟體套疊，即可開始進行立體結構量化

的分析。 

 

 

圖 二十一、正射影像示意圖 
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表 三、Agisoft Metashape Professional 操作流程與參數設定表 

步驟 參數設定 

校正相片 High accuracy, generic preselection enabled, 50,000 key 

point limit, 5000 tie point limit. 

最佳化相片校正 Use all selected by the software. 

建立密集點雲 Medium quality, mild depth filtering, reuse depth map 

disabled. 

建立網格模型 Arbitrary surface type, high face count, interpolation enabled, 

calculate vertex colors enabled. 

在地坐標系設定 取決於比例尺如何設置 

產生 DEM及

Orthomosaic 

Source data: mesh, interpolation enabled 

Blending model Mosaic, surface DEM, enable hole filling  

 

 
圖 二十二、3D 模型建立過程示意圖 

 

5.立體模型誤差評估 

 3D 模型的精確度可以放置比例尺與使用 Metashape 內建功能進行分析，本

研究使用方形霧面印刷之壓克力片做為比例尺，其上印有已知距離的參考點做

為標記，軟體可以自動運算輸入資料與模型的差距得出誤差(圖 二十三)，本研

究之比例尺誤差約於 1mm 左右，另外，亦可直接輸出關於模型的完整報告，內

容包含拍攝面積、拍攝高度、相機校正與地面控制點的誤差等，若單位面積的

拍攝張數重疊大於 9，該角度的模型結構即可達到最大的精確度(圖 二十四)。 
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圖 二十三、使用比例尺進行誤差評估 

 

 

圖 二十四、相機位置與影像重疊圖，以樣框 CJ1907230為例，其他更詳細的資

料可於 Metashape 軟體中 File→Export→Generate report產生 
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5. GIS 軟體操作方法 

 本研究使用 Esri 公司的 ArcGIS Desktop 10.5 系列軟體，過程類似於傳統地

理學分析地形結構，進行線性與表面粗糙度的分析(圖 二十五、圖 二十六)，

軟體中的操作過程如表 四，更詳細的介面解說請參閱附件二。 

 為了分別計算不同底棲特徵的空間參數，需要創建不同類別的圖徵(Feature 

class)，由於珊瑚礁環境的構造複雜，編輯圖徵時使用繪圖板與畫筆(如 Wacom 

Intuos 系列)，搭配創建圖徵中的 Freehand 工具能夠有效且精確的圈選範圍，圈

選的圖徵需儘量避開圖面邊緣，因為邊緣較易出現較不精確或不連續的數值，

最後使用 ArcSence 做更佳的視覺效果呈現(圖 二十七)。 

 

 

表 四、ArcGIS 軟體操作流程表 

步驟 工具或選項 目的 

創建圖層 Add data  匯入 DEM及 orthomosaic 

屬性設定 Layer properties 

→Display /General 

使圖層更易於盼度與設定單位 

創建圖徵 FileGeodatabase  

→ New Feature Class 

不同分類單元創建存放位置(線、面狀

資料分別為 polyline、polygon) 

分類圈選

底棲環境 

Edit Feature → 

Construction Tools 

分別設置切線及圈選表面測量不同分

類單元的線性和表面粗糙度 

參數計算

與輸出 

Add Surface Information 

→ Attribute Table 

分析並輸出立體結構的量化資料 

資料管理 Catalog 提高未來尋找與使用資料的效率 

3D DEM ArcScene 將 DEM產生立體的視覺化效果 
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圖 二十五、ArcGIS 線性空間參數測量，不同色線代表不同走向 

 

圖 二十六、ArcGIS 表面空間參數測量，不同色塊代表不同底棲特徵分類 
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圖 二十七、使用 ArcScene 繪製 3D 的 DEM 及斜度圖(編號 br1907240 樣框) 

 

(二)立體結構量化分析結果 

1.DEM、Orthomosaic 與立體模型 

 截至十月已完成兩個 5 X 5 m樣框與一些更精細的小範圍調查結果如圖 二

十八，其他各種底棲特徵的圖檔可以參閱附件四，至於完整立體模型，由於檔

案過大且不易呈現於紙面，故暫時用螢幕錄影製作為影片檔呈現(連結如附件三

QR code)。 
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圖 二十八、DEM 與 Orthomosaic 調查結果，由上而下分別代表不同測站，Z 軸
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為相對高度 

 

表 五、量化模型基本資料 

樣框編號

ID 

校正相

片數

(張) 

DEM解析

度 

(mm/pix) 

Othomosaic

解析度

(mm/pix) 

3D Model 

(faces) 

調查面積

(m2) 

CJ1907230 808  0.987  0.247 11,826,088 41.8 

CJ1907240 931  1.15 0.287 8,072,625 28.4 

br1907240 215  0.544 0.136 1,790,156 1.08 

 

2.結構量化資料與研究發現 

量化資料目前已計算線性與表面粗糙度(如公式 1、2)以及斜度、高度(包

含最大、最小、平均值)，並分別以方位走向和底棲結構類型做分類，結果使用

Python程式語言進行資料視覺化與相關性分析，需要安裝 pandas、

Matplotlib、seaborn、SciKit-Learn、NumPy等第三方套件。 

 

線性粗糙度(linear rugosity) = 實際長度(m) /線性長度(m) 公式 1 

表面粗糙度(surface rugosity) = 實際面積(m2) /平面面積(m2) 公式 2 

 

 為了瞭解各個參數之間的相關性以及資料集中程度，對所有參數兩兩做散

佈圖(圖十九)並整理一些重要參數於表六，線性粗糙度分析最後得出以下三點

結論(1)不同方位(南北、東西、東北西南、西北東南)的測線結果並無明顯的不

同(2)平均斜度與線性粗糙度有最大的相關性(3)線性粗糙度僅能表示樣框內地

表的起伏程度無法反映出珊瑚覆蓋率。表面粗糙度分析目前僅完成一個樣框(表

七)，因圈選過程非常耗時費力，可以看出分枝形珊瑚粗糙度大於其他種類，礁

岩與表覆形珊瑚則有類似結果，GCP標記為資料品質評估用。 

 

表 六、線性粗糙度分析表 

樣框編號

ID 

底棲環境性質描述 平均斜度 

(percent) 

平均線性

粗糙度 

影響粗糙度的首要

因子(相關係數) 

CJ1907230 葉片及表覆形珊瑚

混合礁岩平台 

395.5479 

 

1.307965 

 

1) 平均斜度 0.85 

2) 最大斜度 0.62 

3) 平均高度-0.54 

CJ1907240 大塊礁岩混和小礫

石及些許漂砂 

802.408 1.358188 1) 平均斜度 0.92 

2) 最大斜度 0.61 

3) 最大高度 0.55 

br1907240 小範圍高解析度分

支狀珊瑚及藻類 

1415.393 

 

2.092492 

 

1) 平均斜度 0.92 

2) 最大坡度 0.74 
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3) 實際長度 0.66 

 

表 七、表面複雜度分析表(編號 br1907240 樣框)，斜度單位為高除長的百分比 

分類 分支形珊瑚 藻類 礁岩 表覆形珊瑚 GCP標記 

平均表面粗糙度 3.102798 2.711016 1.83642 1.849901 1.254027 

平均斜度 

(percentage) 

2144.346 2167.366 998.2513 825.5714 392.0198 

圈選樣本數 

(個) 

12 21 6 9 3 

 

 

圖 二十九、所有參數兩兩散佈圖(編號 CJ1907240 樣框) 

由上而下由左至右參數分別為:線性長度、最小高度、最大高度、平均高度、實
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際長度、最小斜度、最大斜度、平均斜度、線性粗糙度，顏色點代表不同切線

走向，由於三個樣框皆有相似的結果故擇一代表說明。圓圈標示處為相關係數

大之組合，由上至下分別為(1)線性長度與實際長度(2)最小最大高度與平均高

度(3)最大斜度平均斜度與線性複雜度。 

 

針對小範圍進行更高解析度的環繞式拍攝調查，總共分析 8個水深五米左

右的測站，建立的 DEM解析度皆在 0.2~0.3(mm/pix)左右，並圈選 89個底棲特

徵進行分析，分支形有最高的表面粗糙度與 VRM，其次是葉片形的珊瑚，兩者

皆能很好的與其他類型作區分，表覆形的珊瑚與礁岩性質接近，數值介於藻類

與平坦的參考標記之間，團塊形珊瑚與筒狀海綿則較難看出明顯特徵，推測應

是其結構特徵集中且變異大，不適合圈選範圍計算平均值的方式，未來應嘗試

設計更適合的指標，詳細數值資料請參閱表 八與圖 三十。 

 

表 八、不同底棲特徵的各種空間參數平均值 

分類 藻類 分支

形 

表覆

形 

葉片

形 

GCP 

標記 

團塊

型 

礁岩 海綿 

平均表面粗糙

度 
2.186 6.395 1.838 3.438 1.451 1.585 1.873 2.810 

平均 VRM 0.183 0.368 0.128 0.288 0.081 0.098 0.138 0.175 

平均斜度 

(degree) 
40.64 50.41 38.41 45.00 27.92 20.52 37.73 50.23 

平均斜度 

(percentage) 
1701 4506 1023 3316 269 505 1231 2025 

圈選樣本數 14 6 37 5 8 7 9 3 
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(三)使用不同拍攝角度與相機種類之結果比較 

本研究亦初步探討不同取樣方式對產生結果的影響，針對相同的物件在實

驗室中使用 Olympus tough TG4 (4608x3072畫素)相機，比較垂直拍攝角度與

環繞式拍攝角度的差異。垂直角度建立的 DEM有最佳的品質，但其 3D模型會缺

失重疊結構的細節，環繞式拍攝每張照片涵蓋較廣的範圍與角度，可以建立較

為完整的 3D模型，但 DEM會產生較多的誤差，至於使用 GOPRO HERO4 錄影截圖 

(1920x1080畫素)的方式，雖然拍攝過程能較有效率，但也容易使影像模糊造

成 DEM與 3D模型失真(圖 三十一)。因此，當調查對象為大範圍的珊瑚礁區地

景，或是結果僅需取得 DEM，會較適合使用垂直角度的拍攝模式，單一角度的

拍攝有利於流程標準化，也能節省取樣時間，環繞式拍攝則較適合用於建立個

別物體的 3D模型，例如單一的珊瑚群體，若要在相同面積下建立 DEM，需要較

垂直拍攝更多的相片張數，方能達到相近的解析度，至於使用 GOPRO 錄影截圖

的方式，應在水質清澈陽光充足的海域才適合使用，不同方法建立結果的各項

相關參數請見表 九。 

 

圖 三十、不同底棲特徵的各種空間參數箱鬚圖，分別為資料的上下限以及四分位距，圓點代

表離群值，X 軸分別為藻類、分支形、表覆形、葉片形、GCP 標記、團塊形、礁岩、海綿。 
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拍攝方式 

 

圖 三十一、不同拍攝方式建立的 DEM 比較圖，使用較高解析度的相機以垂直

角度拍攝可以有最佳的結果，其餘方式皆會造成一些額外的誤差與干擾(如圖中

地面不規則隆起的部分) 

 

表 九、不同拍攝方式的各項模型參數對照表，由此可知垂直角度拍攝可以有最

佳的解析度與最低的投影誤差(比例尺的誤差來自於人為操作)，環繞式拍攝可

以在有限的張數內涵蓋最大面積，並建立較多點雲數量，因此能有最接近真實

的 3D 模型，使用較高解析度的相機拍攝，也能使結果大幅接近真實。 

 TG4垂直角度拍攝 TG4環繞式拍攝 GOPRO 垂直角度拍攝 

Number of images 81  81 81 

Ground resolution 

(mm/pix) 

0.142  0.161 0.323 

Tie points 83,225 48,510 23,462 

Coverage area (m
2
) 0.555 0.939 1.06 

Reprojection error 

(pix) 

0.902  1.34 1.05 

Scale bar error 

(mm) 

0.05968 0.04147 0.04014 

DEM resolution 

(mm/pix) 

0.566 0.638 1.3 

Dense point cloud 

(points) 

3,476,167 4,253,855 1,090,465 

 

 

(四) 3D模型展示方法 

 立體模型能以多種資料格式展示，密集點雲常以.ply 檔(Polygon File 

Format)匯出，多邊形網格模型多以.stl (Stereolithography)檔、.glb (GL 

模型參數 
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Transmission Format)檔或是附帶.mtl 材質檔的.obj (OBJ)檔輸出，能呈現 3D模型

的網路平台與其對應支援的資料格式整理如表 十。 

 

表 十、模型展示與其格式需求表 

展示平台或形式 資料格式 備註 

Facebook 3D .glb 檔案需小於 3MB 

Facebook 2.5D .jpg 需取得該圖片檔的深度圖(depth map) 

Sketchfab 皆可 免費帳戶單一檔案最大限制為 50MB 

3D printing .obj 需將模型進行前處理，符合 3D列印需求 

Animation .gif .avi 使用 Blender 製作動畫 

Microsoft 

PowerPoint 

.obj .stl  

.ply… 

需更新至 2019版或取得 office 365 

Twitter、

WordPress… 

embed 

URLs 

需先上傳模型至 Sketchfab 並使用該網站的嵌

入式語法 

 

1.社群網站模型展示方式 

 目前熱門社群網站僅有 Facebook 支援直接上傳 3D檔案(2018年 10月推

出，但又於 2019年 9月暫停此項功能)，其他網站如 Twitter、微博尚無法支

援，因有上傳檔案大小與格式限制，因此目前僅適合上傳構造簡單的單一珊瑚

群體或其他小東西，減少模型檔案大小的方法可以執行減面，此功能可以降低

立體結構的頂點與面數量，但會犧牲一些解析度(面數 180,000的模型輸出 OBJ

檔約 13.6MB)，檔案格式也需注意轉換為.glb檔(glTF 2.0)，輸出結果如附件

四。 

 Facebook 另外也支援 3D照片功能，因實際上其並非真的 3D模型，故筆者

以 2.5D模型稱呼，其原理為使用一張圖片以及與之對應的深度圖(depth 

map)，藉由遠景與近景移動速度差異造成類似立體的視覺效果，Agisoft 

Metashape 校正相片後即對每張照片產生對應的深度圖(圖 三十二)，將兩者一

起上傳 Facebook 就會自動產生 2.5D 的貼文(附件四)。 
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圖 三十二、深度圖(左)與對應照片(右) 

深度圖中不同顏色深淺代表與觀察者(照片表面)的遠近距離。 

 

2.3D模型展示網站與材質呈現方式 

 目前 Sketchfab 是免費且自由度高又好操作的模型展示網站，亦可於其上發

現國外其他珊瑚礁研究者的 3D 模型(https://sketchfab.com/johnhrburns)，該平台

支援呈現模型材質功能，因此會有較貼近真實的視覺效果，材質為 3D 模型表

面顏色展開至 2D 平面產生的圖片(圖 三十三)，將 3D 模型檔案與材質圖片檔

打包成壓縮檔，再上傳至 Sketchfab 網站即可使用材質。 

 

圖 三十三、立體模型與材質展示圖  

 

3.其他 3D模型展示方式 

 將珊瑚礁立體模型以 3D列印實體呈現，需先執行修補破面(Close Holes)使

模型表面完整連續(圖 三十四)，再視情況添加用於支撐的結構或平面，但成品

的品質與解析度會受限於 3D列印機台的等級。另外亦可將 3D模型匯入 Power 
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Point 中使得簡報內容更為豐富(附件三)，或是輸出能使用 3D眼鏡觀看的檔案

(圖 三十五)，使用全息投影(Holographic Projection)裝置可以使立體模型無需

額外配戴裝置觀看，僅需自行用壓克力或玻璃製作用於成像的金字塔型稜鏡，

具體方式可以參考(王，2016)，也能結合體感裝置使之更具互動性(范，

2014)，將模型匯出至 Blender 軟體則可以製作精美的動畫

(https://www.blender.org)，未來隨著 AR、VR 技術發展，3D模型能展示的方法

預期會更多且更簡便。 

 

圖 三十四、修補 3D 模型破面示意圖 

 

圖 三十五、搭配 3D 眼鏡觀看之圖檔 

https://www.blender.org/
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圖 三十六、全息投影裝置示意圖，右圖之投影裝置可以使用智慧型手機或平板

取代，有了 3D模型即可簡單製作投影所需之四分割圖檔或影片(左) 

 

(五)討論 

1.DEM 模型的限制 

DEM 通常以 Tiff 圖片格式儲存，每一個像素代表一筆高度資料(圖 三十

七)，傳統上用於地理學研究可以合適的表示地形高程起伏，然而小範圍的水下

地形則有許多複雜且互相重疊的結構，例如桌形、蕈狀的珊瑚或是一些孔穴，

則無法很好的呈現於 DEM 中，如圖 三十八中 3D 模型的分支狀結構底下有重

疊的空間，若轉換成 DEM 則會簡化造成結構失真。雖然 DEM 無法百分之百的

反應真實棲地結構，但相較於傳統方法(如 Chain-tape rugosity 或是 SONAR)已

經更精準且方便許多，做為探討正射角度的結構變化也足夠精準，期待未來能

發展出更合適的分析軟體與研究方法。 

 

圖 三十七、DEM 示意圖 
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圖 三十八、3D 模型(右)與 DEM(左)之比較 

 

2.SfM 與其他 3D 建模方法比較  

基於影像的立體模型建立方法(圖 三十九)，可以適用於拍攝不同尺度的物

件，小至珊瑚的分枝狀結構，大致整個珊瑚礁棲地，只要調整拍攝的影像範圍

並有適當的相片品質，皆能建立高解析度的立體模型，還能取得顏色資訊，而

且僅需普通的拍照設備就可在水下或陸上操作，這些優點皆是傳統聲納或穿越

線調查所缺乏的。但其缺點也是顯而易見的，SfM 方法會受限於環境條件與被

拍攝物體的性質，例如：濕潤、透明、閃爍光澤的表面，都會造成擷取特徵點

時產生誤差，調查環境最好水質清澈、光線充足且沒有漂浮滾動的物體(藻類、

垃圾)覆蓋，最佳拍攝對象為類似石膏雕像等表面粗糙且固定不動的物件，拍攝

相片覆蓋率不足或是缺乏不同拍攝角度亦會使模型不精準，針對其可能產生的

誤差，有研究使用蒙地卡羅法(Monte Carlo method)進行分析(James et al, 2017)，

與其他常見方法的優缺點比較簡單整理如表 十一。 

本研究雖然解析度達到毫米等級，但仍不適合用於計算珊瑚礁體積變化等

更精細的分析，因為台灣北部海岸有太多藻類干擾，而且於 10 米水深處能見度

即不慎理想，所使用的相機等級亦不堪重任。國外研究團隊已累積許多相關的

研究成果，如夏威夷大學的 John H.R. Burns (https://www.johnhrburns.com/) 和加

州大學聖地牙哥的 Stuart A. Sandin (https://scripps.ucsd.edu/labs/sandin/)，其主持

的 100 Island Challenge 亦在台灣南部海域，拍攝許多精細的 3D 模型並展示於

YouTube (https://www.youtube.com/channel/UCR6xc-3SFGmqdYthU8VrgsQ)，國

內則有海生館樊同雲老師，關於珊瑚分枝在實驗室水槽中的生長研究。 
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圖 三十九、3D 建模原理與分類，SfM 為使用三角定位且基於影像的被動方

法，改繪自(Massot-Campos & Oliver-Codina, 2015) 

表 十一、常見 3D 建模方法優缺點比較 

3D 建模方法 優點 缺點 

SfM 運動恢復結構 便宜、好操作、易推廣、有

顏色資訊 

易受各種環境條件影響 

SONAR 聲納 範圍廣、適用於不同水深與

環境條件 

解析度通常較低、不包

含顏色資訊 

LiDAR 光達 解析度高、適用於各種環境 貴、較不易操作 

手持或轉盤式掃描儀 解析度高、可以很便宜 不適用於野外環境或是

大尺寸的拍攝物體 
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3.結構分類之探討 

 關於各種珊瑚的型態分類可以參考資料庫 Coral Trait Database 

(https://coraltraits.org/)，根據其整理的資料可知，不同珊瑚可以展現很多樣的結

構特徵，除了基因造成的差異，各種環境條件(沉積物、流速、光照、重力方

向)、自身群落大小或是附生生物的影響，同種珊瑚亦可能表現出迥異的型態

(Chappell, 1980、Kaandorp et al., 1996、Meroz et al., 2002、Holbrook et al., 

2008)，因此僅看外觀很難做為鑑種的依據，調查不同型態組成的珊瑚群聚是有

生態和保育意義的(Edinger & Risk , 2000)。本研究實際操作上則遇到部分型態

不易辨識的問題，例如表覆形和團塊形，不同粒徑的岩石和沙地時常混合，岩

塊上也常長滿殼狀珊瑚藻和其他大型藻類，造成圈選底棲特徵時有些模糊空

間，需要再依據 DEM 圖或是原始照片輔助辨識。 

 

4.立體結構調查的建議 

(1)慎選調查環境，離島或台灣南部水質清澈、光線充足的海域較為適合，北部

藻類太多且冬季受東北季風影響強烈，能見度和光照普遍不甚理想。 

(2)應結合環境因子(如營養鹽、pH、POC 等)與其他生物指標(魚類、無脊椎生物

豐度與多樣性等)做調查，方能做更多的科學意義探討。 

(3)注意資料儲存與管理，若要進行長時間的比較，調查過程會產生很多影像消

耗大容量的硬體(一個 5X5 公尺樣框 1000 張照片左右所占容量約 3GB)，應預先

規劃好資料如何管理，例如命名原則與儲存路徑等。 

(4)集中硬體資源，統一購置運算效能較好的電腦，才能一次處理調查範圍更廣

的資料，做後續分析也能更有效率。 

(5)需要更多人的參與，應能結合現有的珊瑚礁調查，例如台灣的珊瑚礁總體檢

(https://teia.tw/zh-hant/seawatch/report)，因為都是使用影像資料，結果也能很互

補。 
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五、結論 

 本研究已初步整理相關資料，建立珊瑚礁空間結構量化和分析的標準作業

流程，包含採樣前工具準備、相機設置、潛水攝影採樣流程、立體模型建立、

GIS軟體操作等方法詳細的圖文說明，現階段已完成兩個完整 5X5樣框調查，

以及數個較小尺度但高解析度的珊瑚、海綿等底棲環境特徵量化資料。並且產

生更容易了解底棲環境空間變化的各類模型圖表，例如 DEM、Orthomosaic、

Meah Model、Texture Model，以及使用 ArcScene 產生的 2.5D 地形圖和斜度

圖。推廣各種 3D模型展示方法的方面，目前能夠在 Facebook及不同平台呈現

3D & 2.5D的模型與照片，並建立一個 Sketchfab帳戶(https://sketchfab.com 

/iontuguanyan)存放展示潮境不同底棲特徵的 3D模型，也嘗試使用 3D列印、

Blender動畫以及全息投影等，希望能藉由這些途徑讓社會大眾感到有趣，瞭

解海洋科學研究是有吸引力且值得投資的。潮境保護區珊瑚礁空間結構的生態

特徵，大致探索完入水點附近等深線十米的環境，且完成部分空間參數的相關

性分析，未來期待能累積更多不同時間點與地理環境的調查。 

 

 

六、執行研究中所遭遇之問題與困難 

(一)本研究最初欲探討保育區與非保育區的結構差異，然而初步調查發現空間

結構與底棲環境組成有較大關係，過程中也發現潮境保育區有非常多水肺潛水

與自由潛水等密集的人為活動，故調查之方向欲調整為人為干擾程度對珊瑚礁

空間結構的影響，應較能探討出量化空間參數在不同條件的變化狀況。 

(二)目前設定在地座標系的方法應還有改善空間，因需要手動輸入數值，故必

然會造成一些誤差，未來應會再思考設計更合適的比例尺，或是使用更精準的

定位系統(如水下 GPS)來改善。 

(三)受限於經費限制與使用規範，用於攝影取樣的相機為初階的款式，若能使

用可自由調整光圈與焦距單眼相機加防水殼，將可以取得解析度更高更精確的

珊瑚礁立體模型，電腦硬體設備方面亦如是。 

(四)使用 GIS軟體圈選不同底棲特徵過程非常耗時費力，且部分物件邊緣難以

界定(例如藻類或是被漂砂覆蓋的礫石)，未來應再思考能否靠程式自動化此過

程，或是編列經費請工讀生。 

(五)潮境海域能見度及海流強度變化大，對潛水及攝影技巧是很大的挑戰。 
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附件一、Agisoft Metashape Profession 軟體操作說明(作業系統 win10為例) 

安裝軟體前，先確認硬體設備是否符合需求。  

按 win 鍵+ R 開啟執行視窗，輸入 dxdiag 指令，即可查看詳細的硬體資訊 

 
若硬體未達建議需求，運算過程有可能非常緩慢或是發生電腦當機之狀況。 

 

開啟 Agisoft Metashape

軟體→點選 Tools→

Preferences→GPU，勾

選電腦中所有的 GPU

裝置，並取消勾選 Use 

CPU when performing 

GPU accelerated 

processing。此步驟可

以加速校正相片與建立

密集點雲的速度，其他

階段因目前軟體使用的

演算法尚未支援故無效

果，若無獨立顯示卡可

以跳過此步驟。 
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點選 Workflow→Add Folder 將欲建立 3D 模型之照片匯入，即可在方框處看見

匯入相片之資訊(事前最好將所需照片存在同一資料夾) 

 
於下方視窗中可以剔除過於模糊或是不需要的照片，避免影響模型建立品質 

 

匯入照片後即可點選

Workflow→Align Photos 

並照左圖設定參數，調整

Key point & Tie point limit

可以最佳化校正相片的結

果，50,000 & 5,000 為最合

適的數量，過少有可能使

部分相片無法被校正，過

多則會增加運算時間。 
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若有部分相片無法

校正，可以手動於

照片中特徵明顯處

設置標記 

 

有打綠色勾勾代表相片已被校正，可於 Photos→Change View→Detail，查看包

含焦距、快門、ISO、相機型號等詳細資訊，並依此做排序 

 

點選未校正的照片，按滑鼠右鍵 Add Marker，綠色旗標為手動設置的標記，藍

色旗標則為程式自動設置的標記，檢查每張所需照片皆上標記且無偏誤後，即

可選取已上標記的未校正照片，並於下方視窗點選滑鼠右鍵→Align Selected 

Cameras 再次校正相片，若仍無法校正則需多加幾個標記，或是考慮刪除該張

照片。 

 

校正相片後，可獲得稀疏點

雲，以及所有相機的位置資

訊，左圖中長條線方向為拍

攝角度，也能於 Tools→Tie 

Points→Views Matchs 查看相

片間彼此的對應關係。 
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最佳化相片校正 Reference→Optimize Camera Alignment 使用所有預設選項 

 

若照片品質不佳，也可先使用 Model→Gradual Selection→Reconstruction 

uncertainty 或其他選取工具圈選誤差較大的點並刪除 

 

 

 

 

 

最佳化相片校正後即可建立密集點雲，點選 Workflow→Build Dense Cloud，品

質 Medium 有最佳執行效率，Mild 選項則可保留較多細節 
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建立密集點雲後可觀察到較符合真實的立體結構，使用 Model→Transform 

Region→Resize Region 調整選取範圍(下圖暗色方框處，紅色為地面)，減少選

取多餘的點雲可加快後續建立多邊形網格模型的效率 

 

點選 Workflow→Build Mesh Model，建立多邊形網格模型，設定如下圖 

 

 

 

 

 

 

 

模型建立後有三種展示模式: 

(1)Shaded 有顏色的陰影模式 

(2)Solid 無顏色的陰影模式 

(3)Wireframe 多邊形網格模式 
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左下角點選 Reference 視窗並開啟 GCP 或比例尺的照片，於照片中點選滑鼠右

鍵→Add Marker，依需求設置在地坐標系，可以放大照片更精確地放置標記，

本研究以手動方式將 XYZ 軸相對數值直接輸入標記中，輸入完畢後點選

Update 按鈕更新在地座標資料 

 

設定在地坐標系後即可點選 Workflow→Build DEM & Build Orthomosaic 

  

完成後可與左側面板查看模型建立資訊，點選

File→Export 將結果依需求匯出 
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附件二、Arcgis 系列軟體操作說明(作業系統 win10為例) 

打開 ArcMap→New→Add Data 選擇 DEM 及 Othomosaic 的 TIFF 圖檔加入(注意

製作 DEM 及 Othomosaic 的在地坐標系要相同，否則無法正確疊圖) 

圖層檔案右鍵→Properties 調整圖層顯示屬性獲得更適合的視覺化效果 
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點選 Catalog→於圖層所在資料夾處按滑鼠右鍵→New→File Geodatabase 用於之

後存放與管理圖徵，創建完即可於左側視窗查看其內容 

 

右鍵點選 File Geodatabase 的.glb 檔案→New→Feature Class 建立圖徵，測量線

性的特徵選取 Line Feature，二維的特徵選取 Polygon Feature，點選 Next 至完成 

  

 

 

 

於創建的圖徵點選右鍵→Edit Feature→Start Editing，

開始編輯各類別的範圍，本研究將線性特徵分為南

北、東西、東北西南、西北東南四個走向，二維特徵

有分支狀珊瑚、團塊狀珊瑚、表覆形珊瑚、沙地、礁

岩、桶狀海綿、藻類等底棲環境特徵 
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使用 Start Editing→Freehand 功能搭配數位板與手寫筆可以較仔細與效率的圈選

珊瑚礁區複雜邊緣的圖徵 

 
左側方框可管理圖徵的顯示與屬性，右側則是管理與編輯計算相關的功能 

 

使用 Search 尋找 Add Surface Information 工具 

 

並於該工具中輸入欲計算

的圖徵與 DEM 圖層進行

空間參數計算，並依序勾

選所有可以計算的參數 
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不同底棲特徵圈選範圍的計算則使用 Zonal Statistics as Table 工具 

 

於左側方框右鍵點選圖徵→Open Attribute Table 查看計算結果，並點選左上角

Table Option→Export 選擇.txt 檔的格式匯出 

 

匯出後用 Excel 以逗號分隔開啟，並添加標註其他屬性便於後續資料分析 

 

或是使用 Table to Excel 工具進行批次處理 
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另外開啟 ArcScene 軟體建立有 3D 視覺效果的空間參數圖，並匯入需要的圖檔 

 

右鍵點選圖層→Properties→Base Heights 勾選 Floating on a custom surface 

 

Properties→Symbology 勾選 Use hillshade effect 
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Properties→Rendering 勾選所有 Effects 區塊選項並調整 Optimize 區塊的滑桿 

 

Properties→Display 於 Resample during display using 區塊選擇 Cubic Convolution 
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右鍵點選 Scene layers→Scene Properties 點選 Calculate From Extent 並勾選

Enable Animated Rotation 
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結果如下圖所示 

 

其他不同屬性的圖層以相同步驟設置，記得在圖層→Properties→Base Heights→

Floating on a custom surface 需選擇 DEM 圖層做為參考表面 

 

 

擴充工具 Benthic Terrain Modeler (BTM) 3.0 的下載連結，適合計算各種水下

地形變化的套件 

https://www.arcgis.com/home/item.html?id=b0d0be66fd33440d97e8c83d220e7926 

  

https://www.arcgis.com/home/item.html?id=b0d0be66fd33440d97e8c83d220e7926
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附件三、各類模型展示結果連結 

  

樣框 br190724 樣框 CJ1907230 

  

樣框 CJ1907240 板葉形珊瑚 

  

團塊形珊瑚 平板形珊瑚 
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桶狀海棉 Facebook 3D 貼文 

  

Facebook 2.5D 貼文 本研究 Sketchfab 帳戶 

  

簡易 Blender 動畫 3D 模型簡報影片檔 
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QRcode 讀取簡易教學: 

使用智慧型手機→下載應用程式 LINE→好友 

→加入好友→選擇行動條碼 

→手機鏡頭對準 QRcode 掃描  

結果即可開啟檔案連結。 
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附件四、各種底棲特徵 DEM、Othomosaic 與斜度圖 
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